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1. Owner Information Form - Balancers

Customer Name: __________________________________ Installation Date: ___________________________________
Model Number: __________________________________ Serial Number: _____________________________________
Order Number:___________________________________ Software Number: __________________________________
Sales Representative Name and Number: ___________________________________________________________________
Sales Representative Phone: ____________________________________________________________________________
Service and Parts Representative Name & Number: ___________________________________________________________
Service and Parts Representative Phone: ____________________________________________________________________
Hunter Wheel Balancer - Equipment Training Report
Technicians Trained: Please Print
Technician 1: ______________________________________ Technician 2: ____________________________________
Technician 3: ______________________________________ Technician 4: ____________________________________

Please have trained technicians initial each training item:

Balancer Training Task Tech 1 Tech 2 Tech 3 Tech 4
Safety Precautions, Power On/Off Procedures _____ _____ _____ _____
Overview of Display, Dataset Arms, Spindle Pedal and Wheel Lift _____ _____ _____ _____
Inflation Arm and Bar Code Operation (if applicable) _____ _____ _____ _____
Mounting Methods (Front-Cone, Back-Cone, Flange Plate) _____ _____ _____ _____
Clamping (Quick Thread/Auto Clamp) Operation _____ _____ _____ _____
Centering Check Procedures _____ _____ _____ _____
Balance Mode Selection (Balance Only, Road Force, Straight Trak) _____ _____ _____ _____
Weight Location Entry (Clip-Clip, Clip-Tape, Tape-Tape, Split-Spoke) _____ _____ _____ _____
Installation of Wheel Weights (Servo-stop, Hammerhead, BDC Laser) _____ _____ _____ _____
Recalling TPMS Reset Procedures _____ _____ _____ _____
Performing a Balancer Calibration/Calibration Check _____ _____ _____ _____
Rim Runout Measurement (Rim with Tire, Bare Rim) _____ _____ _____ _____
Match Mounting _____ _____ _____ _____
Tire Stack Operation _____ _____ _____ _____
Printout Selection _____ _____ _____ _____

Installation & Training Acknowledgement: I, the undersigned, do hereby acknowledge that my Hunter Engineering Wheel
Balancer has been installed & is operational. I also acknowledge that the above technicians have been trained to my
satisfaction in those areas of safety & operation as indicated above.

Management Name (print): _____________________________________________ Date: _______________________

Management Signature: _________________________________________________________________________________
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2. Getting Started

This manual provides operational instructions and information required for using Road Force® WalkAway Balancer.
Familiarize yourself with the contents of this manual before operating the Road Force Walkaway Balancer.

The owner of the Road Force® WalkAway Balancer is solely responsible for arranging technical training. The Road Force®
WalkAway Balancer is to be operated only by qualified trained technicians. Maintaining records of personnel trained is
solely the responsibility of the owner and management. This manual assumes the technician has already been trained in
basic balancing procedures.

2.1. For Your Safety

2.1.1. Hazard Definitions
Watch for these symbols:

CAUTION
Hazards or unsafe practices, which could result in minor personal injury or product or property damage.

WARNING
Hazards or unsafe practices, which could result in severe personal injury or death.

DANGER
Immediate hazards, which will result in severe personal injury or death.

These symbols identify situations that could be detrimental to your safety and or cause equipment damage.

2.1.2. Important Safety Instructions - Electrical
Do not operate equipment with a damaged cord or equipment that has been dropped or damaged until examined by a
Hunter Service Representative.

If an extension cord is necessary, it must have a current rating equal to or more than that of the equipment. Cords rated for
less may overheat. Arrange the cord so that it will not be tripped over or pulled.

Never use the cord to pull the plug from the outlet. Do not let cord hang over any edge or contact fan blades or hot
manifolds.

Verify that the electrical supply circuit and the receptacle are properly grounded.

To reduce the risk of electrical shock, do not use on wet surfaces or expose to rain.

Verify the appropriate electrical supply circuit is the same voltage and amperage ratings as marked on the equipment
before operating.

WARNING
DO NOT ALTER THE ELECTRICAL PLUG. Plugging the electrical plug into an unsuitable supply circuit will
damage the equipment and may result in personal injury.

.
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When servicing the Hunter equipment, power must be disconnected by removing the power cord from the electrical outlet.
Ensure that the power switch is in the off position ("O" position) before plugging the power cord into the electrical power
outlet.

2.1.3. Important Safety Instructions - Operation
To reduce the risk of fire, do not operate equipment near open containers of flammable liquids (gasoline). Read and follow
all caution and warning labels affixed to your equipment and tools. Misuse of this equipment can cause personal injury and
shorten the life of the equipment. Keep all instructions permanently with the unit. Keep all decals, labels, and notices clean
and visible. To prevent accidents and/or damage to the equipment use recommended accessories.

Use Hunter equipment only as described in this manual. Never stand on the equipment. Wear non-slip safety footwear when
operating the equipment. Keep hair, loose clothing, neckties, jewelry, fingers, and all parts of body away from all moving
parts. ALWAYS WEAR OSHA APPROVED SAFETY GLASSES. Eyeglasses that have only impact resistant lenses are NOT
safety glasses. Adequate ventilation should be provided when working on operating internal combustion engines.

2.2. Decal Information and Placement
RIGHT SIDE VIEW

Decal 128-1244-2 cautions the operator that spindle rotation may occur with foot pedal depression and to keep clear of
clamping components during Quick-Thread® shaft rotation.

Decal 128-964-2 gives maximum wheel diameter and maximum wheel weight for Road Force® Walkaway.

EN/IEC Class 3R Laser Product Certification is shown on Decal 128-2016-2-08. This labels shows the EN/IEC standards
for a Class 3R Laser Product. An explanation of FDA compliance standards is shown on Decal 128-2016-2-08. FDA
performance standards compliance is shown on the decal.

.
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FRONT VIEW

Optical Scan Laser Apertures.

LEFT SIDE VIEW

Decal 128-391-2-00 cautions that unit may automatically
start upon closing of the hood when Hood Autostart is
enabled.

Laser apertures are located at either end of TDC header.

BACK VIEW

Decal 128-381-2 warns operator not to remove cover of Road Force Walkaway due to risk of electrical shock and not to use
below garage floor level.

.
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ETL certification standards are outlined on Decal 128-1640-2. Additionally, users are cautioned not to use balancer below
garage floor level.

2.3. Specific Precautions
POWER SOURCE

The Road Force® Walkaway Balancer is intended to operate from a power source
that will apply 230VAC +10% / -15%, 1 phase, 10 amp 50/60 Hz, power cable
includes NEMA 20 amp plug, L6-20P, between the supply conductors of the power
cord. The power cord supplied utilizes a twist lock connector, NEMA L6-20P. This
machine must be connected to a 20 amp branch circuit. Please refer all power
source issues to a certified electrician.

CAUTION
A protective ground connection, through the grounding conductor in the power cord, is essential for safe
operation. Use only a power cord that is in good condition.

NOTICE
For information on converting from single phase NEMA L6-20P plug to thee phase NEMA L1520P plug refer to
Form 5350-T, “NEMA L6-20P to NEMA L15-20P Power Plug Conversion Instructions.”

OPTICAL SCAN LASER

.
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The Optical Scan Laser is a Class 3R laser designed to measure the profile of wheel assemblies. The laser is not a field
serviceable part. No maintenance is to be performed on the laser. (Class 3R Laser) Decal: 128-2016-2-08

Wavelength: 658nm

Laser Power for Classification: < 5mW

Emission Type: CW

Divergence: 3.0 mRad

Beam Diameter: 8.5 mm at aperture

Fan Angle: 57°

The Optical Scan Laser is a Class 3R laser designed to measure the profile of wheel assemblies. The laser is not a field
serviceable part. No maintence is to be performed on the laser. (Origanal 3R Laser) Decal: 128-1785-2-08

Wavelength: 635nm

Laser Power for Classification: < 5mW

Emission Type: CW

Divergence: 1.1 mRad

Beam Diameter: 6.5 mm at aperture

Laser Beam spot size at 10m: <10mm

HAMMERHEAD® TDC LASER INDICATOR (Optional)

The TDC (Top Dead Center) Laser Indicator is designed to aid in applying clip-on weights. The laser is not a field serviceable
or adjustable part. Use caution in regard to reflective materials around the laser and never look into the laser beam.

LASER RADIATION - DO NOT STARE INTO THE BEAM OR VIEW DIRECTLY WITH OPTICAL INSTRUMENTS.

Viewing the laser output with magnifiers or related optical instruments within a distance of 100mm from the laser aperture
may pose an eye hazard.

.
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2.4. Turning Power On/Off

Equipment Installation and Service

Only a Hunter Factory-Authorized Representative should perform installation. This
equipment contains no operator serviceable parts. All maintenance and repairs
must be referred to a qualified Hunter Service Representative

PUSH BUTTON SWITCH

The Road Force® Walkaway is equipped with a push button power switch located
on the left side of the LCD support. Use this switch for normal shut down and
restarting procedures.

The safety hood must be closed before touching the green “START” button, to
spin the wheel.

MAIN POWER SWITCH

The main power ON/OFF switch is located on the back of the balancer
cabinet. To power the balancer “ON,” press the “I” side of the ON/OFF
switch. To turn all power the balancer “OFF,” press the “O” side of the
ON/OFF switch

CAUTION
To prevent loss of data, always use the push button switch on
the LCD support to power the balancer on and off. Then use
the main power switch to remove power to the entire unit.

.
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2.5. Equipment Specifications

ELECTRICAL

Voltage: 230VAC +10% / -15%, 1 phase, 50/60 Hz, power cable includes
NEMA 20 amp plug, L6-20P

Amperage: 10 Amperes

Wattage: 3450 Watts (peak)

AIR

Air Pressure Requirements: 100-175 PSI (6.9-12.0 bar)

Approximate Air Consumption: 4 CFM (113 Liters/Minute)

ATMOSPHERICS

Temperature: +32°F to +122°F (0°C to +50°C)

Relative Humidity: Up to 95% Non-condensing

Altitude: Up to 10000 ft. (3048 m)

SOUND PRESSURE LEVEL

Equivalent continuous A-weighted sound pressure at operator's position does not exceed 70 dB (A)

2.5.1. Explanation of Symbols

Alternating Current

Earth ground terminal

Protective conductor terminal

ON / OFF (Supply) condition

Risk of electrical shock

Stand-by Switch

Not intended for connection to public network

.
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2.6. Main Screen Components

1. Tire Stack / Vehicle Plan View Tab 10. SmartWeight® Savings Odometer

2. Load Roller 11. Road Force® / WalkAway Savings Odometer

3. Clip Weight Plane 12. Road Force® Limits Display

4. Tape Weight Plane 13. Road Force® Wheel Assembly Display

5. Context Sensitive Menu 14. Road Force® Menu Button

6. Wheel Assembly Display 15. eCal Button

7. Start / Stop / Servo Button 16. Spec Lookup

8. SmartWeight® Menu Button 17. Wheel Dimensions Tab

9. Imbalance and Couple Force Display 18. Passenger / SUV / Truck mode

.
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2.7. Road Force Walkaway Components

.
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3. Operating the Balancer

Main Balance Screen

Pull-out tabs are on the left for Tire Stack/Vehicle Information (upper
tab) and Wheel Dimensions (lower tab). Buttons along the right side
allow navigation to other screens and activities. Buttons in the lower left
and right portions of the screen allow navigation to Road Force® and
SmartWeight® procedures and options.

Main Balance Screen - Error Pop-ups

If the operator attempts to perform an illegal operation in the main
balance screen, an error pop-up with appropriate information will be
displayed. For example, the screen is displayed if operator attempts to
start a spin without first lowering the hood.

Main Balance Screen - “Tire Rash”

After a Road Force® spin (or StraightTrak®), a colored road rash will
appear on the tire. This signifies the measured Road Force® of the
assembly, and corresponds to the value and color presented in the Road
Force® animation in the lower left portion of the screen.

Main Balance Screen - Prompt Text

When the operator needs more info in a non-error condition, prompting
text will appear in the lower portion of the screen.

Main Balance Screen – Enable and Disable Load Roller

To enable or disable the load roller in the main balance screen, touch
the load roller on the screen to cycle through all available options.

.
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Main Balance Screen – WalkAway Inflation System

When the operator initiates Auto-Set Pressure on a tire for balance
spin, WalkAway Inflation prompt will display instructions for tire stem
positioning and attaching Air-Chuck using Auto-Chuck button.

Main Balance Screen – Performing a Spin

During a loaded balance spin, several things occur on the screen. First,
the green Start button is replaced with a red Stop button and the tire
assembly spins in 3D space. As soon as the balance portion of the spin
is complete, weights will appear on the screen.

During each portion of the loaded spin, the text in the lower portion
of the screen will alert the operator about what is being measured. If
StraightTrak® is enabled, the lateral measurement will begin after Road
Force® has been measured.

After the loaded spin is complete, and if dimensions have been entered,
the 3D scene will show all information necessary to balance the
assembly including; Assembly Force, Weight Amounts, Weight Type,
and Weight Position.

Main Balance Screen – Servoing To Position

If servoing is enabled in Setup, the balancer will servo either the inner
or outer place weight position to topdead-center. To servo to the next
position, the operator can either touch the “Servo” button or touch the
corresponding weight amount.

Main Balance Screen – Road Force ® Buttons

Touching the Road Force® button expands a set of button options. The
load roller can be disabled/enabled. The operator can change the Road
Force® limits. The “Show Savings” button can show detailed views of
the cost savings from Road Force® balancing. And finally, the operator
can select one of three Road Force® procedures: ForceMatching®,
Measuring Individual Lateral Force, and 180 Matching. Display of
historical data is also available.

.
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Main Balance Screen – SmartWeight® Buttons

Touching the SmartWeight® button expands a set of button options.
SmartWeight® can be disabled or enabled, Performance Mode can be
disabled or enabled and Weight savings can be viewed.

Secondary Screens - Print Screen Button

Any secondary screens used to perform balancing procedures or to view graphs will have a print button which will send a
copy of the current screen to the printer. The background will turn white to help conserve ink.

.
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4. Balancing Procedures

4.1. Wheel Lift Operation
RAISING THE WHEEL ASSEMBLY

CAUTION
When operating the wheel lift, make sure to maintain two-handed control of the wheel assembly.

Slide the appropriate Bullseye™ Centering System collet onto the spindle shaft. Position wheel lift carriage at the end of the
wheel lift rail.

Press the lift control foot pedal “down” until the trolley carriage is at its lowest level. Roll the wheel assembly onto the wheel
lift carriage. Raise the lift control foot pedal “up” to move the wheel trolley into a position where the wheel assembly can be
installed onto the spindle shaft. Release the lift control foot pedal.

Slide the tire/wheel assembly onto the spindle and center on the collet. Verify that the wheel assembly is centered vertically
on the spindle shaft.

NOTICE
Lower wheel lift as needed to clamp wheel, but keep the wheel lift carriage in place under the wheel assembly.

Clamp wheel onto the spindle shaft. Keep the wheel lift carriage in place under the wheel assembly and close the hood. The
lifting assembly will automatically lower and park the carriage below.

NOTICE
Allowing the balancer to park the wheel lift carriage in place under the wheel assembly will make the removal
and lowering of the wheel assembly easier and quicker.

LOWERING THE WHEEL ASSEMBLY

Starting with the wheel lift carriage parked under the wheel assembly; raise the lift control foot pedal “up” to move the lifting
assembly to the wheel assembly. Release the lift control foot pedal when the assemblies contact one another. Remove
wheel clamp.

Slide the carriage with wheel assembly to the end of the wheel lift rail. Press the lift control foot pedal “down” until the
carriage is at its lowest level. Roll wheel assembly from carriage.

4.2. CenterChecking® Wheel Centering Feature
CENTERINGCHECK®

CenteringCheck® is an inspection or verification of the wheel’s mount to balance to identify possible centering errors, thus
recognizing improper measurements. From the main balance screen, touch the “CenteringCheck” button and follow the
on-screen instructions.

AUTOMATIC CENTERING CHECK

.
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During every spin, the wheel is optically checked for off centering and bent wheels. If the balancer detects a centering issue
it will prompt a technician to perform a Centering Check. This diagnostic spin compares the centering data of the first and
second spin.

The sensitivity of the Center Check diagnostic can be adjusted in the setup menu. Go to “Tools” > “Advanced” > “Setup” >
“Prompted Centering Checks”.

4.3. Front / Back Collet Mounting

Collet mounting is one of the most common and reliable ways to mount
wheels on balancers.

The Bullseye™ Centering System is a set of collets that provides wheel
centering coverage for most passenger cars and light trucks. Due to the
degree of taper on the collets, multiple collets may be used on a wheel
assembly. As long as the collet is in the center bore of the wheel, and
does not bottom out, it can be used.

Select the proper Bullseye Centering System™ collet by placing it in the
center bore of the wheel to be balanced. Select the collet that contacts
the wheel nearest the center of the collet.

USING THE PLASTIC WHEEL MOUNTING SPACER

The plastic wheel mounting spacer, 46-320-2, may be used to prevent
scratches on wheels where the standard plastic cup and scratch
guard cannot be used.

The plastic wheel mounting washer may also be used when mounting
a wheel with a large offset that is between collet sizes. Use of the
washer can improve centering ability by increasing cone pressure
against the wheel.

USING THE 9-INCH ALLOY WHEEL PRESSURE CUP

In some cases, the wing nut / SpeedClamp™ contact point of the
wheel may be extremely wide, and the standard clamp cup will not
properly contact the wheel hub area. In these cases, the optional nine
inch alloy wheel pressure cup may be used in place of the clamping
cup.

FRONT COLLET MOUNTING

NOTICE
Front collet mounting is generally not recommended.
It should only be used in instances where traditional
backside collet mounting is not possible.

This procedure utilizes a collet inserted from the front side of the wheel instead of the backside as previously described.

.
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HEAVY WHEEL CENTERING

Heavy wheel centering may benefit by (1) pulling the tire away from the hub face at top dead center while tightening the
wing nut or (2) use of optional wheel lift to position heavy wheel onto shaft and cone. This helps the wheel to overcome
gravity against the hub or spacer.

4.4. Specialized Mounting Conditions
COLLET / FLANGE PLATE MOUNTING

Some wheels may be centered using the lugholes and center bore with a flange plate and collet. It is important that a back
mounted collet be used to support and center the wheel when using flange plates. (Figure 32.) Flange plates are useful
when the wheel cannot be properly centered off the hub bore with a collet alone because of improper fit, interference, or
lack of a center hole.

Insert Index Pin into the Flange Plate as follows:

1. Align the index slot in the hub with the index slot in the guide.

On the hub, the one slot NOT numbered (located between the two 1-inch holes) is the index slot. On the guide,
the one slot NOT grouped with the other slots is the index slot.

The thumbscrew through the side of the flange plate limits the movement of the guide plate to keep the two
index slots crossing each other.

2. Hold the adjustable flange plate with the hub (numbered slots) on facing you.
3. Insert a pin assembly, 135-378-1, into the index slots as

follows:

• Turn the guide to center the intersection of the two
index slots.

• Align the tab at the end of pin to the index slot in hub.

• Insert the end of pin through the intersecting index
slot in the guide.

• Push down on the pin and rotate the pin a quarter turn
to lock in place

4. A pin is inserted in the index slot for every wheel, regardless of the number of lugs.
5. Along with the index pin, insert additional pin assemblies, 135-378-1, into each of the correctly numbered slots

as follows:

• Turn the guide to locate the index pin near the center of index slot.

• Align the tab of the pin assembly to the numbered slot.

• Insert the end of pin assembly through the slot and into the intersecting slot of the guide. If more than one
intersecting slot is present, use the one located in the center of the slot.

• Push down on the pin and rotate a quarter turn to lock in place.

• Repeat pin installation to fill each of the correctly numbered slots.

SET FLANGE PLATE FOR A WHEEL AS FOLLOWS:

WARNING
DO NOT pry or hammer stuck pins from adjustable flange plate.

.
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The correct flange adaptor setup is determined by the
following:

Measure and set the bolt circle diameter and number of
studs to use against the lug holes. Set the number of
lugholes as follows:

• A three-lug wheel uses three studs.

• A four-lug wheel uses four studs.

• A five-lug wheel uses five studs.

• A six-lug wheel uses three studs.

• A seven-lug wheel uses seven studs.

• An eight-lug wheel uses four studs.

NOTICE
For Ford 7 X 150 mm lug pattern, align the
index pin to the 150 mm mark and insert the
remaining six pins, 135-378-1, into the #7
slots. Insert the end of pin through the 3/16
inch holes in the guide plate.

Choose the correct taper design of flange studs to fit the
wheel lug seats. The mounting area of the flange stud
must match the design of the wheel’s lughole seat or
depression.

The flange plate must be able to apply pressure to the center of the wheel while maintaining perpendicularity to the shaft.

NOTICE
If the lug seats are unevenly machined or worn, an optional universal flange adaptor with compressible studs
or bolt on lugs may be used to more accurately mount the wheel with the collet.

6. Choose the type of pin sleeve that best fits the lugholes in the wheel.

• 3/4 inch diameter conical pin sleeves, 106- 145-2, will fit smaller lugholes.

• 1-inch diameter conical pin sleeves, 106- 143-2, will fit larger lugholes.

• 7/8-inch diameter spherical pin sleeves, 106- 144-2, will fit lugholes of many German autos

NOTICE
If the installation of pin sleeve is difficult or not secure, clean inside of pin sleeves and pin assemblies,
then apply light machine oil to mating surfaces.

7. Push the pin sleeve to the end of pin assemblies.

USE ADJUSTABLE FLANGE PLATE TO MOUNT WHEEL TO BALANCER AS FOLLOWS:

1. Determine the cone (or collet) that best fits the center
bore of the wheel to be balanced. Choose the cone the
contacts the wheel nearest to the center of the cone.

2. Place the wheel-mounting cone on the spindle against
the spring plate.

3. With the wheel on the garage floor, adjust the flange plate to match pins with the lug pattern of the wheel.
Adjust the diameter of the pin pattern on the flange plate by turning the guide plate against the hub plate.

4. Tighten the thumbscrew located on the guide side of the flange plate to lock the guide plate and pin positions.

.
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WARNING
The pin pattern on the flange plate must be adjusted to the diameter of the lug pattern of the wheel, prior
to mounting the flange plate to the balancer. The pins will NOT self adjust as the wing nut is tightened. If
the pins are not properly adjusted to the lug pattern, the pin tabs, adjustable flange plate or wheel may be
damaged.

5. Mount the wheel with the inner rim facing the balancer and centered on the cone.
6. Mount the adjustable flange plate to spindle with pins matched to lug holes.
7. Install the pressure ring (or clamping cup) and wing nut on the spindle shaft against the adjustable flange plate.
8. Secure the entire assembly by firmly tightening the wing nut.

DISASSEMBLE FLANGE PLATE SET-UP AS FOLLOWS:

1. Pull pin sleeves from the end of pin assemblies.
2. Remove the pin assemblies from the numbered slots by pushing down and rotating each pin a quarter turn.

Leave the index pin on the adjustable flange plate.
3. Place pin sleeves and pin assemblies in the storage bin located on side of balancer

EXPANDABLE COLLET MOUNTING

An expandable collet should NOT be used with the Road Force® Walkaway due to the amount of force applied by the load
roller.

Using the Pressure Ring and Spacers

The Pressure Ring clips on to the wing nut. It is used in lieu of the clamping cup.

It may also be used in place of a clamping cup if space is limited
between the wheel and the end of the spindle.

The pressure ring should be used to prevent the wing nut from
directly contacting an adaptor or a collet. It will act as a bearing to
enable higher clamping forces.

HUB RING SPACERS

These spacers are designed to build a larger pocket when using extra
large collets. It also provides a location for the centering pins found
on some dual wheel configurations.

4.5. Wheel Assembly Selection for Saving Spin Data
SAVING SPIN DATA

.
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Saving Spin Data The Road Force® Walkaway automatically tracks the wheel assembly currently being balanced.

The balancer assumes that the technician is working “around the vehicle” by beginning at the LEFT FRONT and working
around the vehicle in a clockwise fashion. Successive spins are stored as either “before” or “after” data based on the
following rules:

• If the weight displays read “OK/OK” or is blank, assume the next complete spin is “before” data.

• If the weight displays read anything other than “OK/ OK” or is blank, assume the next complete spin is “after” data.

MEASUREMENT STORAGE

The Road Force® Walkaway automatically tracks the wheel assemblies as they are balanced. As the wheel assemblies are
balanced, their status can be viewed as they would appear on the vehicle currently being serviced.

Select the VirtualView® button to expand the VirtualView® panel. The panel can be further expanded to show detailed
information for up to the last eight wheel assemblies balanced.

PRINT SUMMARY

A printout is available that incorporates a detailed image of each wheel assembly with the stored measurements. If a
measured value is out of tolerance compared to the recalled specification, the value will be printed in red. From the main
balance screen, select “Print” and “Vehicle Summary”.

The Vehicle Summary screen will be displayed.

SINGLE ASSEMBLY ROAD FORCE® PRINTOUTS

The Road Force® Walkaway allows for single wheel assemblies to be printed for situations when Road Force® is only
needed for a single wheel. Select “Print” to send before and after balance summary results to the printer.

4.6. Balance Modes

SmartWeight Balancing Technology®

SmartWeight Balancing Technology® is a method of reducing forces on a
wheel during balancing. SmartWeight® is not a procedure.

Instead, it measures the forces of side-to-side movement and up-and-down
shake and computers weight to reduce these forces. This reduces the
amount of correction weight used, balancing time required, check spins
needed and “weight chasing”.

SmartWeight saves the shop time and money.

DYNAMIC BALANCING - TRADITIONAL BALANCING MODE

NOTICE
SmartWeight Balancing Technology® is the default balancing method and is the most recommended way to
accurately balance wheel /tire assemblies.
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NOTICE
Enter wheel dimensions before selecting dynamic balancing. If SmartWeight® mode is enabled in setup, the
balancer will return to SmartWeight®balancing upon dimension entry.

Dynamic balancing will always display two weight planes.It provides a more complete balance than static balancing.
Dynamic balancing should be selected whenever possible to minimize vehicle vibration.

Switching from SmartWeight Balancing Technology® to Traditional Dynamic Balancing

At any time, SmartWeight Balancing Technology® can be switched to standard balancing provided that both standard and
SmartWeight® balancing modes are enabled in setup. Touch the SmartWeight® button to display the Smart-Weight® menu
buttons.

NOTICE
When changing to traditional dynamic balancing mode, weight amounts as well as weight placement locations
change.

STATIC BALANCING - TRADITIONAL BALANCING MODE

NOTICE
Enter wheel dimensions before selecting dynamic balancing. If SmartWeight® mode is enabled in setup, the
balancer will return to SmartWeight® balancing upon dimension entry.

Static balancing provides a less desirable balance than dynamic balancing. Dynamic balancing should be selected
whenever possible to minimize vehicle vibration.Switching from Traditional Dynamic Balancing to Traditional Static
Balancing.

In non-SmartWeight® mode, the balancer can be switched from dynamic balancing to static balancing.

DYNAMIC MODE STATIC MODE

Blinding and Rounding

In non-SmartWeight® mode, the balancer can display either an “actual” or “blinded and rounded” amount of imbalance.

Touching the magnifying glass icon next to the dynamic or static icons will toggle blinding and rounding on or off.
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DYNAMIC MODE, binding/rounding STATIC MODE, binding/rounding

4.7. Walkaway Inflation System
Walkaway Inflation System provides preset tire pressure setting to ensure accurate Road Force Measurement® (before
and after matching) and safe assemblies for final mounting on the vehicle. Road Force Walkaway can reduce as well as
increase the tire pressure. Pull hose from inflation arm (while in the “Balance”or “Runout > Road Force®” screens) and the
WalkAway Inflation screen will automatically pop up.

Pressing the red button on the air chuck will retract chuck collar, allowing it to
be placed onto valve stem. Release the button and the chuck will lock on.

Upon sensing that the air hose is attached to the valve stem, the
tire pressure will automatically be set to the target air pressure. The
target air pressure is set by the operator, touching the “up” or “down”
arrows on the inflation screen.

.

Page 25 of 64



In cases of a tire with pressure below 15 psi, “Auto-Set Pressure” can
be selected to begin filling.

Touch “Hold Pressure” or “Exit” at any time to halt auto pressure
setting.

Once air chuck is connected to valve stem, the hood can be closed.
Balancer will automatically disconnect air chuck when desired
pressure is reached, and balancer will then perform a spin.

When the tire reaches the dialed-in pressure, the on screen tire
graphic will turn green.

When inflating a tire, WalkAway timer is a countdown to hood
up time. Includes inflation, balance spin, and road force spin if
enabled.

The WalkAway Inflation screen exits automatically if the air hose is
removed from the valve stem, or if manually exited by touching the
“Exit” button.If the procedure is stopped before completion, an error
message will be displayed indicating that target pressure has not
been achieved.

For safety, spinning is prevented for the following conditions: When
the Inflation Station screen is displayed, the hose is not at the storage
position The hose is pressurized (not disconnected from the valve
stem).

4.8. Quick-Thread® Wheel Clamping
Quick-Thread® is an “intelligent” DC drive motor control feature that allows motor assisted threading for fast installation
and removal of the Road Force Walkaway wing nut.

DANGER
Keep clear of clamping components during Quick-Thread shaft rotation.
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WARNING
Quick-Thread® does not tighten the wing nut! In Quick-Thread® rotation, torque allowed is minimal. Therefore,
the wing nut must still be hand-tightened before balancing.

NOTICE
Because of the software limited torque control, you must loosen the wing nut before Quick-Thread® will
remove it.

SpeedClamp™ Wheel Clamping (Optional) SpeedClamp™ is an optional spindle equipped with a pneumatic clamping device
that eliminates the spin-on type wingnut. Double tap the foot pedal to clamp and unclamp.

4.9. Motor Drive/Servo-Stop, Spindle-Lok®, and Safety Hood
MOTOR DRIVE / SERVO-STOP

The intelligent DC motor drive on the Road Force® Walkaway is able to position and hold the tire assembly in position for
weight application, apply different amounts of torque, and control the speed and direction of the spindle.

When the “Start” button is touched with the hood in the raised
position, while weights are showing, the motor will automatically
rotate the wheel to the next weight plane and hold the assembly in
position for weight or mark application.

Alternatively, touching the weight amounts will achieve the same
results.

SPINDLE-LOK® FEATURE

Depressing the foot pedal will lock the spindle. Locking the spindle will stabilize the wheel for attaching weight sat precise
locations if automatic weight positioning is disabled, and will allow for tightening and loosening of the wing nut. Do not use
the Spindle-Lok® as a brake to stop a spinning wheel.

NOTICE
Depressing the foot pedal will cancel Servo-Stop.

WARNING
Using the Spindle-Lok® to stop a spinning wheel may result in personal injury or damage to the balancer.

SAFETY HOOD FEATURES

Hood Autostart

The balancer can be set to automatically spin the wheel upon hood closure. After a spin, the hood must be raised
completely before the balancer will Autostart again. For safety, the balancer will not Autostart in “Calibration,” “Setup,”
“Diagnostics,” if no balancing procedure is selected, or if the Inflation Station hose is out of its “home position.”
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NOTE
Hood should be closed at a consistent speed per hood angle sensor.

Auto Hood Feature

The balancer can be set to automatically raise the hood after a spin has been completed.

WARNING
Keep body parts and items away from the hood while a spin is in progress. Never reach under the hood while
the balancer is performing a runout measurement or balance spin.

4.10. Balancing Procedures for Specific Weight Types and Placement using
TruWeight®
The Road Force® Walkaway offers both automatic and manual modes for weight placement.

Automatic Mode Manual Mode

Clip-clip, tape-tape and mixed weight modes are available for both dynamic and static balancing. With these options,
correction weights can be placed at an infinite number of locations, based upon the choice of the operator. Automatic is the
default setting, automatically choosing the correct type of weights and locations determined by optical scan.

TruWeight® shows the operator exactly how to place the weights on the wheel. Place them exactly as displayed on the
screen.

SmartScan™ Dimensions Entry

From the main balance screen, the operator can take wheel dimensions using SmartScan™ dimension entry.This is done
automatically by SmartScan’s™ inner and outer cameras when lowering the hood and performing a balance spin. Runout,
rim dimension, spoke and weight plane location, as well as the wheel weight type (either clip or tape) are calculated
automatically by SmartScan™on every spin.

NOTICE
If a wheel weight type other than what is determined by SmartScan™ is desired, users may touch a different
weight plane to change weight type.

NOTICE
Incorrect or missing spoke locations do not affect the balancer’s ability to properly balance wheels. Rim
profile calculations are performed separately from spoke identification. This can be verified by comparing the
appearance of the 3D generated profile to the actual wheel. Simply touch the“Enter Spokes” button and enter
spoke locations manually to correct spoke identification errors.

Single Weight Placement
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Occasionally, regardless of the weight mode, a single tape weight is shown in the middle of the wheel. Place the weight as
shown on-screen. The crucial task is to lineup the center of the weight with the laser line. The depth of placement does not
need to be exact, use features of the rim profile to determine the location.

4.10.1. Balancing Procedure Using Clip-On Weights

Verify the correct clip-on weight type will be used for the wheel that is
being balanced.

Verify that the wheel is clean and free of debris. Remove all previous
weights.

Mount tire/wheel assembly. Close safety hood. Touch the green
“START” button if “Hood Autostart” is disabled.

As the wheel is spinning, the amount(s) of corrective weight(s)
needed will be shown on the screen. This time can be used to find
and prepare the needed weights.

NOTICE
Once weight amounts are shown on the screen,they can be toggled to display either ounces or grams by
pressing the “oz” or “g” graphic shown after the weight amount.

After wheel comes to a complete stop, raise the safety hood.

The Road Force® Walkaway will find the top-dead center (TDC) for
the first weight plane if “Servo-Stop” is enabled. “Servo-Stop” will hold
the wheel in the TDC position while the weight is applied.

Attach the weight amount shown on the screen for the selected
weight plane to the correct side of the wheel.

TruWeight® shows the operator exactly how to place the weights on the
wheel. Place them exactly as displayed on the screen.

NOTICE
If the optional HammerHead® TDC weight locator is installed,
the weight should be applied at the location marked by the
laser.
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Touch the green “START” button with the safety hood in the raised
position. The Road Force® Walkaway will rotate the wheel to TDC
for the next weight plane. The view of the wheel will also change to
the next plane view and the weight amount for the next plane will be
displayed in green.

NOTICE
Optionally, pressing the next plane weight amount will
rotate the wheel to TDC for the next weight plane.

Attach the weight amount shown on the screen for the selected weight
plane to the correct side of the wheel.

TruWeight® shows the operator exactly how to place the weights on the
wheel. Place them exactly as displayed on the screen.

NOTICE
If the optional HammerHead® TCD weight locator is
installed, the weight should be applied at the location
marked by the laser.

Close the safety hood to perform a check spin. Left and right weight
plane displays should show “OK”after the check spin.

The clip-on weight balancing procedure is complete.
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4.10.2. Balancing Procedure Using a Combo of Clip-On & Adhesive (Tape) Weights (Mixed Weights)

Verify that the wheel is clean and free of debris.Remove all previous
weights.Mount tire/wheel assembly.

Close the hood to perform a balance spin to measure the distance,
diameter, runout and rim width dimensions.

As the wheel is spinning, the amount(s) of corrective weight(s)
needed will be shown on the screen. This time can be used to find
and prepare the needed weights.

After wheel comes to a complete stop, raise safety hood.

The Road Force® Walkaway will find the top-dead center (TDC) for
the first weight plane if “Servo-Stop” is enabled. “Servo-Stop” will hold
the wheel in the TDC position while the weight is applied.

Attach the clip-on weight amount shown on the screen for the left
weight plane to the inner rim of the wheel.

TruWeight® shows the operator exactly how to place the weights on
the wheel. Place them exactly as displayed on the screen.

NOTICE
If the optional HammerHead® TDC weight locator is
installed, the weight should be applied at the location
marked by the laser.

Touch the green “START” button with the safety hood in the raised
position.
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NOTICE
Optionally, pressing the next plane weight amount will
rotate the wheel to the next weight plane.

The Road Force® Walkaway inner camera quickly locates and marks
adhesive weight positioning.

The laser locator automatically displays a vivid line at bottom dead
center after a wheel has been spun. The laser turns off when the
wheel is spun again.

CAUTION
Use of controls or adjustments or performance of procedures other than those specified herein may result in
hazardous radiation exposure.

With the servo enabled, attach the adhesive weight using the weight
amount shown for the right weight plane on the screen.

TruWeight® shows the operator exactly how to place the weights on
the wheel. Place them exactly as displayed on the screen.

Close the safety hood to perform a check spin.

Left and right weight plane displays should show “OK”after check
spin.

MIXED WEIGHTS balancing procedure is complete.

4.10.3. Balancing Procedure Using Adhesive (Tape) Weights

Verify that the wheel is clean and free of debris. Remove all previous
weights.

Mount tire/wheel assembly. Close the hood to perform a balance
spin. Information is computed automatically.

As the wheel is spinning, the amount(s) of corrective weight(s)
needed will be shown on the screen. This time can be used to find
and prepare the needed weights.

NOTICE
Once weight amounts are shown on the screen,they can be toggled to display either ounces or grams by
pressing the “oz” or “g” graphic shown after the weight amount.

After wheel comes to a complete stop, raise the safety hood.
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NOTICE
If Auto Hood is enabled, the hood will raise
automatically.

The Road Force® Walkaway Servo-Activated Laser automatically
locates adhesive weight positioning.

The laser weight locator automatically displays a vivid line after a
wheel has been spun. The laser turns off when the wheel is spun
again.

CAUTION
Use of controls or adjustments or performance of procedures other than those specified herein may result in
hazardous radiation exposure.

With the servo enabled, attach the adhesive weight using the weight amount shown for the left weight plane on the screen.

TruWeight® shows the operator exactly how to place the weights on
the wheel. Place them exactly as displayed on the screen. Touch the
green “START” button with the safety hood in the raised position.

NOTICE
Optionally, pressing the next plane weight amount will
rotate the wheel to the next weight plane.

Close the safety hood to perform a check spin. Left and right weight
plane displays should show “OK” after the check spin.

ENABLE DRAGGING FEATURE

The Enable Dragging feature allows the user to drag tape weights to a specific area of the wheel.

Touch the “Measurements” icon on the left side of the screen after a balance spin. Touch the “Enable Dragging” button on
the right hand side of the screen. Users can now drag the tape weight(s) as desired.

4.11. Rim Dimension Manual Entry

RIM DIMENSION MANUAL ENTRY - TAPE / TAPE

In the event of an SmartScan™ failure, balancing can still be
performed by using a tape measure to manually input rim
dimensions.

Press the dimension button on in the upper left-hand portion of the
screen.
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Press the Manual Entry button in the upper right-hand
portion of the screen.

Use a tape measure to measure the lengths called out
on-screen. Touch each box and enter the appropriate
measured dimensions. When finished, press OK to end
manual dimension entry.

RIM DIMENSION MANUAL ENTRY - CLIP / CLIP

In the event of an SmartScan™ failure, balancing can still
be performed by using a tape measure to manually input
rim dimensions.

Press the dimension button on in the upper left-hand
portion of the screen.
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Press the Manual Entry button in the upper right-hand
portion of the screen.

Use a tape measure to measure the lengths called out
on-screen. Touch each box and enter the appropriate
measured dimensions. When finished, press OK to end
manual dimension entry.

4.12. Blinding and Rounding
In non-SmartWeight® mode the balancer can display either an “actual” or “blinded and rounded” amount of imbalance.

“Blind” is a tolerance or amount of imbalance required before an imbalance amount is displayed. “Round” allows the
balancer to display weight imbalance to a desired increment. The blind and round values can be changed in the “Setup”
procedure.

While in the “Balance” primary screen, blind and rounding may be disabled by touching the screen to highlight the
magnifying glass. The actual amounts of imbalance for the selected mode will be displayed when “Blind and Rounding” are
disabled as shown below.

Dynamic mode, blinding/rounding is disabled Static mode, blinding/rounding is enabled
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4.13. Tape Weight Menu & Split Spoke Feature
TAPE WEIGHT MENU

By touching a weight on the wheel, such as the strips of weight shown below, a weight style menu will appear. This offers
the ability to change to another style of tape weight and/or split the weight. This can improve balancing accuracy.

Split Weight®

The split weight® software fans the weight on selected plane into two smaller weights. Repeated touches of “Split
the Weight” will provide alternate choices where the weights fan further apart but become larger to accommodate the
correction needed.

Correcting Large Imbalances

Split Weight® can also be used to apply three weights when needed.

SPLIT SPOKE FEATURE

When in either mixed weight or adhesive weight modes, (dynamic or static), correction weights can be hidden behind the
spokes of a wheel.

Split Spoke® can be turned on as used as the default based on the wheel scan. If the Split Spoke® feature of hiding
weights behind spokes is to be used, touch “Spokes” > “Enter Spokes”. Follow the on screen instructions. Move to the next
spoke and repeat. 2 spoke locations are entered. Continue the balance procedure as normal.

NOTICE
When SmartWeight® is enabled in conjunction with wheel spoke entry, the “SmartSpoke®” weight locator
feature can in many instances allow the use of weight at only one spoke when it would have required two
using conventional spoke mode balancing.

4.14. Optional HammerHead® TDC Laser Clip-On Weight Locator
The balancer will find the TDC for the left or right weight plane if “Servo-Stop” is enabled. “Servo-Stop” will hold the wheel in
the TDC position while the servo-activated laser automatically locates TDC to aid in fast clip-on weight positioning.

The HammerHead® TDC Laser System automatically displays a vivid line at top dead center after a wheel has been spun.
The laser turns “off” when the wheel is spun again.

WARNING
Use of controls or adjustments or performance of procedures other than those specified herein may result in
hazardous radiation exposure.

Never look directly into the laser. Doing so may cause serious injury.

Operation accessible radiation fields Specific Precautions / HammerHead®
TDCLaser System

Use caution in regard to reflective materials
around the laser and never look into the
laser beam

Any necessary repair or maintenance
should be done by the factory only. The

Wavelength: 635-660nm

Laser Power for Classification: <1mW via 7mm aperture

Beam Diameter: <5mm at aperture

Divergence: <1.5mrad x <2rad

Transverse Beam Mode: TEM00
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WARNING
Use of controls, adjustments, or performance of
procedures other than those specified herein may result
in hazardous radiation exposure.

Do not stare into the beam or view directly with optical
instruments. Doing so may cause serious injury. Do not
intentional use a reflective device to enhance or re-direct
the laser. Do not operate the laser if the cover or seal is
damaged.

There is no required maintenance or service to keep the
HammerHead™ TDC Laser System in compliance. The laser is not
a field serviceable or an adjustable part.

HammerHead™ TDC Laser System has no
field serviceable parts. The unit should never
be opened or modified.

This unit should never be opened or
modified.

4.15. TPMSpecs™ Feature & Hunter Help
TPMSpecs™ Feature

NOTICE
TPMS specifications can also be found on Hunter Aligners (with WinAlign 11.0 and greater) and online at
UnderCarInfo.NET (subscription service).

The TPMSpecs® feature identifies vehicles with tire pressure monitoring systems. It also provides in depth information
regarding the service of TPMS.

• TPMS Type

• Sensor Type

• Reset Required on Tire Rotation or Replacement

• Reset Tool Requirement

• Required Tools

• Reset Procedure

• TPMS Hints

• Information / Disclaimers

TPMSpecs® may be accessed in two ways

Option 1:

From the Main Balance screen, scan a VINbarcode.
TPMS information for the vehicle scanned will be
automatically retrieved and displayed.

Option 2:

From the main balance screen, touch the “Tools” >
“TPMS” buttons.

The main TPMSpecs® screen is displayed. Select the make, model and specifics of the vehicle being serviced.

The “AT A GLANCE” overview starts each vehicle TPMS specification. The first image shows the type of TPMS sensor
on the vehicle. The following three images show the requirements for servicing the wheel: process, scan tool and OEM
scanner. The red border, yellow border or grayed appearance of the image denotes the requirement as required, optional or
not required. Red and white striped border indicates the requirement is possibly required; refer to the explanation below the
images.

Scroll up or down by dragging the scroll bar, or touching the “up” and “down” arrows on the right side of the screen.

Touch the “Home” button to return to the main TPMSpecs® Menu. Touch the “arrows” to navigate backward or forward.
Touch the “print” button to print the current page. Touch “X” to return to the balancer screen.

Hunter Help - Video Player
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The Video Player feature provides tips and procedures
for using the HD Elite®. To access the Video Player:

From the main balance screen, touch the “Help” >
“Launch Video Player” buttons.

The main video menu screen is displayed.

Select a topic from the menu to view the video.

NOTICE
The video screens may change as new content is added.

The selected video will begin playing.

Go back in the video by touching the “back” button. Play the video by touching the “play” button. Stop the video by touching
the “stop” button. Go forward in the video by touching the “forward” button. Decrease the video volume by touching the “-”
button. Mute the video volume by touching the “mute” button. Increase the video volume by touching the “+” button.

Exit the video player by touching the “Exit” button.

Launch Help

The Hunter Help feature provides tips and procedures for Hunter balancers and tire changers. It also provides a Rolling
Smooth Sample Quiz. Additional content will be added to the Hunter Help files and can be updated as it becomes available.
To access Hunter Help:

From the main balance screen, touch the “Help” > “Launch Help” buttons.

The Main Menu of Hunter Help is displayed. Select the item to view by touching the selection.

NOTICE
The help screens may change as new content is added.

Some items have sub-menus that will display help on a specific topic. Touch to view the selected topic. Detailed help on
specific topics can also be printed. Select “Print” to print the page currently being viewed.

Scroll up or down by dragging the scroll bar, or touching the “up” and “down” arrows on the right side of the screen. Touch
the “Home” button to return to the main Hunter Help Menu.

Touch the “arrows” to navigate backward or forward. Touch the “print” button to print the current page. Touch “X” to return
to the balancer screen.
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5. SmartWeight® Balancing

5.1. SmartWeight® Balancing Technology
SmartWeight® Balancing Technology is not a procedure. Rather, it is a technology that measures the forces of couple
side-to-side shimmy and static up-and-down shake and computes the correction weight required to reduce these forces.
This reduces the amount of weight used, reduces time, reduces check spins, “chasing weights”, and saves shop time and
money.

SmartWeight® Balancing Technology can reduce the number of steps in the balancing process. Not only does
SmartWeight® Balancing Technology give the customer abetter riding vehicle, it also helps the environment by using
less corrective weight.

Static and non-rounding modes are eliminated to simplify operation. Always enter at least two weight positions during
wheel measurement in SmartWeight® balancing mode. All other functions are identical to the traditional balancing method.

Static and Dynamic Imbalance Sensitivity As a general rule of thumb, to achieve the best balance on an average sized tire
and wheel assembly Residual static imbalance should be less than 1/4 ounce (7grams).

• Residual couple imbalance should be less than 3/4ounce (21 grams).

• Residual couple imbalance is preferred over remaining static imbalance.

• It takes much more residual couple imbalance weight to cause a vibration than the same amount of static imbalance
correction weight.

• The larger the diameter used for weight placement,the smaller the amount of correction weight is required for static
correction.

• The wider the distance between the two weight placement locations, the smaller the amount of correction weight is
required for couple correction.

• If static balance is the only option, always verify that the remaining couple residual imbalance is within acceptable
tolerance. This can only be verified using SmartWeight® balancing.

NOTICE
SmartWeight® balancing performs this check automatically.

5.2. Dynamic Weight Planes
SmartWeight® requires the operator to enter at least two weight planes. This balancing method will automatically
determine if one or both weight planes require a weight to be added. This eliminates “blinded” static single plane balancing,
which alone may not be sufficient to solve couple vibration issues.

The Road Force® Walkaway balancer offers two primary ways to balance tires:

SmartWeight® Balancing Technology Traditional balancing technology
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Both of these methods can balance tires dynamically. The main difference being that SmartWeight® will reduce the amount
of corrective weight in a basic wheel balancing situation and automatically optimize static force reduction and single plane
weight placement.

5.3. Using SmartWeight® Balancing Technology

The SmartWeight® balancing forces display varies greatly from the
standard balancing display.

SmartWeight® tire graphs independently display the static and
couple forces within a tire/wheel assembly. A single plane (static)
mode and non-round off modes are no longer necessary.

The traditional “static” and “dynamic” modes are eliminated. The
traditional non-round off mode is eliminated. These modes are no
longer necessary with SmartWeight® balancing.

The red-dotted line represents the acceptable amount of force the tire
and wheel assembly can have that will not result in a ride problem.
Any forces below that line will be shown in green. Any forces that
are above that level will be shown in red and indicate an excessive
amount of force.

Install a tire/wheel assembly as normal. Rim measurements are not
required to determine if the balance forces are exceeded. Lower the
hood and spin.

Prior to balance spin, the tire graphs will display no color.
The SmartWeight® balance force graphs will display red
for excessive forces and green for acceptable amounts
of force.

If the SmartWeight® balancing procedure requires correction
weights, wheel dimensions will be required. Close the hood and
perform a spin.

After the spin is complete, the screen will display the amount and
location of corrective weight necessary.
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Install the weights as indicated on the screen using the TruWeight®
feature. Lower the hood to re-spin and check the balance.

The balancer displays “OK,” indicating that the force levels are
reduced to within the acceptable tolerances.

5.3.1. Switching from SmartWeight® Balancing to Traditional Dynamic Balancing

At any time, SmartWeight® Balancing Technology can be switched to
standard balancing provided that both standard and SmartWeight®
balancing modes are enabled in setup. Touch the SmartWeight®
button to display the SmartWeight® menu buttons.

NOTICE
SmartWeight® Balancing Technology is the default
balancing method and is the most recommended way
to accurately balance wheel / tire assemblies.

Touch the Disable SmartWeight® button. The balancer is now in
traditional dynamic balancing mode.

NOTICE
When changing to traditional dynamic balancing mode,
weight amounts as well as weight placement locations
change.

5.3.2. Switching from Traditional Dynamic Balancing to Traditional Static Balancing
In non-SmartWeight® mode, the balancer can be switched from dynamic balancing to static balancing.

Dynamic mode is selected: Touch the static mode icon for static mode balancing.

Blinding and Rounding

In non-SmartWeight® mode, the balancer can display either an “actual” or “blinded and rounded” amount of imbalance.
Touching the magnifying glass icon next to the dynamic or static icons will toggle blinding and rounding on or off.
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Dynamic mode, blinding/rounding
is disabled:

Static mode, blinding/rounding is
enabled:

Enable Performance Mode

In SmartWeight® mode, the balancer
can be switched to performance mode.

Touch the Enable Performance Mode
button.

Table 1. Show Savings

Touch the Show Savings button.
The SmartWeight® Savings screen
will be displayed.

Touch the Show Details button
to view details of SmartWeight®
savings. The Weight Savings screen
will be displayed.

Touch the Investment Return
button. The SmartWeight® and
Road Force® Investment Return
screen will be displayed.
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6. Road Force Measurement® Procedures

6.1. Load Roller Operation
The load roller runs parallel to the tire and applies a perpendicular load on the assembly to take information required for the
Road Force Measurement® system. It is capable of applying up to 1250 pounds of force. The amount of force placed on
the tire is dependent upon the tire’s diameter and stiffness. The load roller will not overload the tire.

WARNING
Do not use the load roller on assemblies with studded tires.

NOTICE
It is important that the air pressure of the tire is set to specifications prior to using the HD Measurement®
system. Incorrect tire pressure will affect the results. If the Road Force® Walkaway is equipped with the
Inflation Station feature, the tire can be easily set to the specified air pressure.

The load roller can be enabled and disabled by touching the load roller on the screen.

When the load roller is enabled, the screen will display
the load roller with enabled settings.

When the load roller is disabled, a red “X” appears on the
load roller.

The load roller can also be enabled and disabled by touching the Road Force® button then touching the “Toggle Roller”
button.

Road Force® with Limits Enabled

When the load roller is enabled, “LT Tires,” “P-SUV Tires,” or “P Tires” Road Force® limits can be changed. Changing the “LT
Tires,” “P-SUV Tires,” or “P Tires” selection will change the limit specifications for Road Force® and rim runout.

NOTICE
The load roller cannot be enabled in “Bare Rim Spin” mode.

To change Road Force® limits touch the “Road Force®” > “Change Limits Type” button. Touch the type of limits to use.

6.2. Forcematching®
Forcematching® is a method of aligning the stiffest spot of the radial tire road force first harmonic (once-per-revolution
component) with the average low point of the radial rim runout first harmonic to decrease vibration in the wheel assembly.
This type of match mounting has been done with expensive equipment by the tire/wheel manufacturers and OEMs for years
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to provide the smooth ride associated with a new vehicle. The Road Force® Walkaway provides “Forcematching®” at a
service level.

When the Road Force® Walkaway performs a spin with the load
roller enabled, it measures the road force of the wheel assembly.
ForceMatch® is enabled on every Road Force® spin.

NOTICE
It is important that the air pressure of the tire is
set to specifications prior to using the Road Force
Measurement® system. Incorrect tire pressure will
affect the results.

ForceMatch® - Display of Data

Press ForceMatch® in the RoadForce menu and after the assembly
has been spun, the ForceMatch data will display on screen.

The upper left corner of the screen displays Road Force® and runout
data. A 3D display of the assembly is shown, with corresponding
“chalk marks” on both the tire and rim.

Matching the chalk marks will produce the minimum available Road
Force® in the assembly

Buttons on the right allow the operator to return to the main balance screen, view details and plots, and change the data
being viewed.

Touching “Show After ForceMatching” will change the 3D scene
(matching up the chalk marks and showing the resulting Road
Force® change in the color spectrum on the tire) as well as show the
predicted resultant assembly force and diagnosis (upper left data).

Forcematching® - No Runout

If the operator accesses ForceMatching® without the required data
having been measured, the screen will prompt the operator. A 180
match will need to be done if this happens.

Forcematching® - Show After Prediction

Touching the “Show After ForceMatching” button will change the 3D
scene (matching up the chalk marks and showing the resulting Road
Force® change in the color spectrum on the tire) as well as show the
predicted resultant assembly force and diagnosis (upper left data).

ForceMatch® Procedures

To correct road force by using ForceMatch®: Rotate the tire Road Force® high spot on the wheel to TDC, or with the hood in
the raised position and the servo enabled, touch “START.”
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Mark the tire with a piece of chalk or a marker at TDC

Rotate the rim low spot on the wheel to TDC, or with the hood in the
raised position and the servo enabled, touch “START.” Mark the rim
with a piece of chalk or a marker at TDC.

Use a tire changer and align the tire and rim marks to one another.
Refer to the operation instructions for the tire changer in your shop.

NOTICE
If the wheel assembly can be corrected by Forcematching®, the results can be viewed prior to removing
the assembly from the balancer by touching “Show After ForceMatching”. If the wheel assembly cannot be
corrected by ForceMatching®, the diagnosis box will display “ForceMatching will not bring assembly within
limits” and may suggest component replacement.

Touching the “?” button will display detailed information
about the procedure

6.2.1. Match Codes
Match codes can be used to obtain optimal ForceMatch® results between multiple tire and rim assemblies. They are
especially helpful when high Road Force® values are encountered. The former Hunter MatchMaker® feature used a similar
system.

When a tire and rim assembly are balanced using ForceMatch®, a
number (match code) is displayed above the tire.

This is the value of the high spot on the tire. It is an arbitrary number.
The match code is 12.
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When the tire and rim assembly is rotated to the low spot on the rim,
a number (match code) is displayed above the tire.

This is the value of the low spot on the rim. It is an arbitrary number.
The match code is 4.

Use a tire changer and align the tire and rim marks to one another as
performed in the standard ForceMatch® procedure.

By matching the highest tire match code value with the highest rim match
code value, the Road Force® values can be reduced in a set of two or more
tire and rim assemblies.

The diagram shows a set of four tires and rims and the best use of match
codes to reduce Road Force® values.

A routine practice of marking the match code values on the tires and rims when using ForceMatching® can reduce the
overall time needed to perform optimal ForceMatch® results.

180 Matching

180 Matching will minimize Road Force® in the tire and wheel assembly. It requires a tire changer, as the tire will be
re-positioned about the wheel during the procedure.

The 180 Matching procedure can be launched by
touching the “Road Force®” > “Procedures” > “180
Matching” button.

The progress bar at the top of the screen indicates to the
operator how far along the procedure has progressed.
Mount the assembly on the balancer. Set the tire
pressure to the vehicle manufacturer’s specification.
Lower the hood to start the Road Force® measurement.
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Position the valve stem at 12:00 and touch “Enter Valve
Stem”.

Mark the tire with a piece of chalk or a marker with a “V”
opposite the valve stem as indicated. Touch “OK” or tap
the foot pedal when completed.

Use a tire changer and rotate the rim 180 degrees
relative to the tire, aligning the “V” mark with the valve
stem. Mount the assembly on the balancer. Position
valve stem at 12:00 and press “Enter Valve Stem”. Lower the hood to start the Road Force® measurement.

6.2.2. Encountering ForceMatch® Prediction Errors
Below are some reasons why the Road Force® Walkaway may not match or quantify the value of the tire or the assembly.

• Incorrect Mechanical Wheel Mounting on the Shaft: This can be caused from worn or damaged adaptors, rust or debris
on the wheel, shaft, hub, adaptors, or a cone contacting a wheel on an irregular surface. Verify proper mounting by
performing a centering check.

• External Rim Measurement vs. Actual Bead Seat Measurement: There is a high correlation between external and
internal measurement, however the operator must consider each wheel design individually. Some cast or closed-
faced wheels cannot be accurately measured externally. The tire must be removed for accurate bead seat runout
measurements.

• Air Pressure Readings Before and After Matching Differ: The air pressure should remain constant between each
measurement. Always inflate tires to the recommended pressure specified by the vehicle manufacturer.

• Incorrect Tire Bead Seating Procedures: Tire technology is always changing. Today’s vehicles 48 Balancing Procedures
require the tire to be designed to tightly adhere to the wheel, preventing slippage between the two components. As a
result, incorrect tire bead seating procedures are becoming more of an issue in solving vibration complaints.
In many cases, a wheel will display high non-uniformity values because of increased tire bead interference, wheel design,
or improper bead seating procedures. If the tire is re-loosened from the wheel and properly lubricated and remounted,
the level of non-uniformity may decrease dramatically. On sensitive vehicles, sometimes there is benefit to slightly
over-inflating the tire, deflating the air, and then re-inflating to optimize bead seating.

• Insufficient Use of Tire Mounting Lube During Mounting: “Lube is Good!” Proper lubrication on the tire bead and rim
areas including bead seat, hump, balcony, and drop center are vital in achieving proper seating of the tire bead to the
wheel assembly. Aggressive acceleration or braking should be avoided for the first 500 miles to prevent tire to wheel
slippage.
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• Rim Safety Hump Design ‘Hangs Up’ Tire Bead During Bead Seating: Some types of wheels use a square safety hump
that may further inhibit uniform tire bead seating. This further underscores the importance of proper lubrication and
bead seating procedures.

• Temporary Flat Spotting: Flat spotting may occur when the tire is in one position for an extended period of time, such
as a parked vehicle, improper storage of the tire, and temperature extremes. Measurements for force and balance will
stabilize as soon as the tire is driven for a few miles. This important issue can also affect traditional wheel balancing
procedures.

• Excessive Lateral Runout of Tire and/or Rim: A tire or wheel with high lateral readings may affect the predicted results
of radial force after ForceMatching®.

6.2.3. Do's and Don'ts of Road Force Measurement

• Tires may need to be warmed up to remove temporary flat spots prior to testing.

• Tire inflation pressure must meet vehicle manufacturers specifications.

• Verify the wheel is centered.

• Use the approved adaptors for the Road Force® Walkaway. Use approved wing nut provided and tighten with two hands
to ensure full clamping force.

• The tire/wheel assembly must be free of debris.

• Bare rim runout measurements are required if the wheel design does not permit external measurement of the outer bead
seat area.

• Use realistic Road Force® measurement limits for the vehicle being tested.

• If chosen limits have been exceeded, never use Road Force® measurement alone to replace a tire unless specified by
the manufacturer.

6.2.4. Road Force® Savings

Savings generated through prevented comebacks using the Road
Force® roller can also be viewed. Touch the Road Force® button.

In the Road Force® menu, touch the Show Savings button.

The Road Force® savings screen will be displayed.

6.3. StraightTrak Lateral Force Measurement (LFM)
StraightTrak® is an optional feature that corrects vehicle pull problems by suggesting that the tires be placed at specific
locations on the vehicle. If the vehicle being tested has unidirectional tires, or different size tires front and rear, not all of the
displayed options will be valid.

Performing a StraightTrak® LFM Procedure:
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Mount the tire/wheel assembly centered on the shaft of the Road
Force® Walkaway. Use care to make sure the wing nut is well
tightened.

Choose the appropriate balancing procedure for the particular type of
rim construction.

Check the tire pressure. Inflation Station will automatically inflate or
deflate the tire to the preset air pressure. When the tire pressure is
correct, the tire graphic on the screen will turn green.

NOTICE
Lateral force varies significantly with tire inflation pressure. For accurate results, it is important that the
inflation pressure for each tire is set to the correct value.

Enter rim dimensions by performing a spin. Press the green “START” button if “Hood Autostart” is disabled. After the radial
measurements are taken, a lateral force sensor measures forces exerted in the lateral (axial) direction.

The drive system then reverses direction and again measures the forces exerted in the lateral (axial) direction. After wheel
comes to a complete stop, raise the safety hood.

Perform any tire/wheel Force Matching® required to reduce radial Road Force® disturbances.

Apply the appropriate balance weight.

Touch the “Tire Stacking” tab button.

The screen will show the first wheel spun and automatically assign
tag 1 to the assembly.

Attach the corresponding identifying tag to the valve stem of the tire/
wheel assembly or number the assembly with a tire crayon.

The “Tire Stacking” tab can be opened or closed when performing the
procedure. The HD® Elite will continue to automatically number the
spun assemblies.

Touching the “Tire Stacking” tab button again will close the “Tire
Stacking” tab window but automatic numbering will continue.

Mount the second tire/wheel assembly on the HD® Elite and perform
ForceMatching® (if needed) and balancing. The screen will show the
second wheel spun and automatically assign tag 2 to the assembly.

.

Page 49 of 64



The vehicle plan view will show the net tire pull (if any) for the two
measured tire/wheel assemblies.

Mount the third tire/wheel assembly on the Road Force® Walkaway
and perform ForceMatching® (if needed) and balancing. The screen
will show the third wheel spun and automatically assign tag 3 to the
assembly.

After tagging the third tire/wheel assembly, the vehicle plan view will
show suggested placement of the tire/ wheel assemblies so that the
net lateral force, produced by tire conicity, exerted on the steer axle of
the vehicle is minimized.

Mount the fourth tire/wheel assembly on the Road Force® Walkaway
(if needed) and balancing.

The screen will show the fourth wheel spun and automatically assign
tag 4 to the assembly.

After tagging the fourth tire/wheel assembly, the vehicle plan view
will show suggested placement of the tire/ wheel assemblies so that
the net lateral force, produced by tire conicity, exerted on the steer
axle of the vehicle is minimized.

It will also show net pull (if any). Various choices of tire placement may be chosen to optimize the vehicle for least pull
and/or least vibration. Touch the buttons on the right to cycle through various options showing or hiding “Road Force®”,
“Show Least Pull”, “Show Least Vibration” and “Print” results.

6.3.1. Disabling StraightTrak®

Any instance when lateral force is not an issue (such as when
measuring single assemblies), StraightTrak® can be turned “OFF” to
reduce cycle time.

StraightTrak® can be disabled by touching the load roller on the
screen until the StraightTrak® logo is no longer visible.
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6.3.2. Interpreting the Tire Stack

1. Spin has been performed. Tire imbalance has been measured but not
corrected. Tire is still in process.

2. Tire has been balanced, but neither Road Force, nor lateral force has
been measured.

3. Imbalance was measured but not corrected Tire has been forced to
the tire stack by the technician.

4. Tire has been balanced and Road Force has been measured, but
lateral force has not been measured.

5. Tire has been balanced, Road Force has been measured, and lateral
force has been measured.

6. Tire has been balanced, Road Force has been measured, and
individual lateral force has been measured.

Vehicle Plan View The vehicle plan view provides a graphic depiction
of the information that is gathered by the Road Force® Walkaway
during a loaded spin.

Touching the “Tire Stacking” tab button shows the vehicle plan view
in a simplified form. It shows only the net pull on the assembly after
having spun four assemblies.

The vehicle plan can be expanded to show individual Road Force®
measurements, individual lateral force measurements, assembly
diameters and other pieces of information about measured
assemblies.

To access this expanded plan view, touch the arrow button at the top
right of the plan view. To return to the simple plan view, touch the
arrow button again.

6.3.3. Net Tire Pull

Net pull indicates the direction and the magnitude of pull, due to the
tires, that the vehicle will be subject to, if the tire/wheel assemblies
are mounted on the vehicle as currently shown on the screen.

Direction will be to the right, or to the left, indicated by an arrow.
Magnitude is measured in pounds (lbs) or Newtons (N) and is further
indicated by the directional arrow.
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CHANGING TAG NUMBERS

While on a vehicle plan view screen, touching and “dragging” tags will show the effects of changing assembly locations.

When the first tire/wheel assembly is ready to be tagged, the only option will be to tag it as tag 1. The second tire/ wheel
assembly will default to tag 2, however you may change it to tag 1 dragging and dropping the tag to the second location.
The third and fourth tire/wheel assemblies may be tagged by accepting the default (the next sequential tag).

FORCING A TIRE ONTO THE TIRE STACK

In some cases, it may be desirable to "force" a tire to the
tire stack even though it has not been balanced. Touch
the chassis tab.

Observe the current tire stack.

NOTICE
In this example, no wheels have been
balanced or previous data has been cleared.

Locate weight locations / input rim dimensions by
performing a balance spin.

.

Page 52 of 64



NOTICE
Wheel has been balance spun but no
weights have been applied.

Touch the chassis tab. A semi-transparent tire appears
on the stack.

NOTICE
Since this wheel has not been balanced,
a “Not Balanced” icon appears on the left
edge of the semi-transparent tire.

Touch the “Save to Tire Stack” button. The tire is now
solid but the “Not Balanced” icon indicates that no
corrective weights have been applied.

REMOVING A TIRE FROM THE STACK

Touch and hold your finger on the tire you wish to
remove. A trash can icon will appear at the center of the
screen. Without lifting your finger from the screen, drag
the tire to the trash can and release the tire.

A prompt will ask you, “Are you sure you want to remove
this tire from the stack?” Select “OK” to continue, or
“Cancel” to cancel.

ROAD FORCE®

Touching the “Hide Road Force” button will turn off the Road Force® listings for all assemblies. Touching the “Show Road
Force” button will turn Road Force® listings back on. Road Force® indicates the amount of vertical (radial) Road Force®
variation remaining in the tire/wheel assembly after ForceMatching®.

Magnitude is measured in pounds (lbs), Newtons (N), or kilograms (kg). To minimize vibration, the tire/wheel assembly with
the largest amount of Road Force® is typically positioned farthest away from the driver (right rear). Even though the front
(steer) axle tires may be switched to change the direction of net pull, the rear tire/wheel assembly with the largest amount
of Road Force® will still be positioned farthest away from the driver.

SHOW LEAST PULL

Touching the “Show Least Pull” button will rearrange the tags to show the least pull. By touching “Show Least Pull,” the
placement of tire/ wheel assemblies on the vehicle that will yield the least net tire pull will be shown. This positioning tries
to place the two tire/wheel assemblies on the front axle that have the same amount of pull, but in opposite directions when
on the vehicle.

SHOW LEAST VIBRATION

Touching the “Show Least Vibration” button will rearrange the tags to show the least vibration. By touching “Show Least
Vibration,” the placement of tire/wheel assemblies on the vehicle that will yield the least vibration will be shown.

This positioning will place the tire/wheel assembly with the greatest amount of Road Force® on the passenger side of the
rear axle (farthest from the driver). The tire/wheel assembly with the second highest Road Force® will be placed on the
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driver’s side of the rear axle, and the tire/wheel assembly with the lowest Road Force® will be placed on the driver’s side of
the front axle.

6.3.4. Printout
Touching the “Print” button will allow the operator to print summary information.

By printing the summary, the operator has a printed reminder of where to position each tire/wheel assembly on the vehicle
to minimize the effects of lateral force.

If the desired results are not evident during a test drive, the operator
may refer to the alternate placements shown on the printout, without
the need to repeat the entire procedure.

The printout can be used to explain the effects of lateral force and
the steps taken to reduce their adverse effect to the customer.

Touching the “Vehicle Summary” button opens the Vehicle Summary
screen. Custom vehicle summaries can be created by selecting the
items to include in the printout.

When a custom summary is created, it can be saved by touching the “Save This Option Set” button. Custom vehicle
summaries can be recalled by touching the “Recall Next Option Set” button. Print information can also be entered in the text
boxes on the Vehicle Summary screen.

Use “Header:” to display shop name, address, and phone, or any
custom message to appear on the printout.

Use “Name:” to display the customers name.

Use “Vehicle:” to display the vehicle being serviced.

Use “Mileage:” to display the vehicle mileage.

Use “VIN:” to display the vehicle identification number.

Touching in any text field will launch the on-screen keyboard. Use the
on-screen keyboard to type in the desired fields.
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6.3.5. Inflation Pressure & Extra Info

Inflation pressure of each tire, as recorded by the Inflation Station, is
displayed on the summary printout. A blank reading indicates that the
tire was not measured (inflated or deflated) with the Inflation Station
feature.

Summary printout will print the tire pressure rounded to the nearest
tenth of a pound. The range allowable to fill each tire may vary on
the printout by one or two pounds per assembly. This is considered
normal due to the “green bar” tolerance allowable during automatic
inflation.

Extra Info

When viewing the extended plan view, detailed information about
each assembly may be viewed by touching “Touch For Extra Info”.

Information such as corrective weight amounts used and individual
assembly lateral force will be displayed. Touch “Touch To Close” to
close the Extra Info panel.
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6.4. Individual Lateral Force Measurement
Lateral force can be measured on individual tire/wheel assemblies.

The Individual Lateral Force Measurement procedure can be
launched by touching the “Road Force®” > “Procedures” > “Measure
ILF” button. The progress bar at the top of the screen indicates to the
operator how far along the procedure has progressed.

Mount the assembly on the balancer. Set the tire pressure to the
vehicle manufacturer’s specification. Lower the hood to start the
Road Force® measurement.

The first spin will be recorded as spin 1. Use a tire changer and
remove the tire from the wheel. Flip the tire over and remount the tire
to the wheel.

Set the tire pressure to the vehicle manufacturer’s specification.

Mount the assembly on the balancer. Lower the hood to start the
Road Force® measurement.

The second spin will be recorded as spin 2.

After the assembly is spun, Individual Lateral Force is measured and
saved.

Use a tire changer and remove the tire from the wheel.

Flip the tire over and remount the tire to the wheel.
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Set the tire pressure to the vehicle manufacturer’s specification.
Mount the assembly on the balancer.

Touch “OK” to return to the balance screen, then balance the
assembly.

The Individual Lateral Force measurement results may be viewed by
touching the “Tire Stacking” tab button.

To calculate Individual Lateral Force, use the following formula:

Net pull / 2 = Individual Lateral Force

Example: 6 lbs / 2 = 3 lbs Individual Lateral Force.

6.4.1. Road Force Savings

Savings generated through prevented comebacks using the Road
Force® roller can also be viewed.

Touch the Road Force® button. In the Road Force® menu, touch the
Show Savings button.

The Road Force® savings screen will be displayed.
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7. Optional Balancer Procedures

7.1. Tools

The Tools button contains equipment information and set up options.

Set Up

The “Set Up” screen contains a list box of balancer set up items.
Select the item you wish to set up and follow the on screen prompts.

Maintenance History

From the main balance screen, touch the “Tools” > “Advanced” >
“Maintenance History” button.

The Maintenance screen displays general balancer history. Pressing any of the grey boxes will show a flyout with more
information.

TPMS

From the main balance screen, touch the “Tools” > “TPMS” buttons.

The main TPMSpecs® screen is displayed. Select the make, model and specifics of the vehicle being serviced.

Make Model Specifics

The “AT A GLANCE” overview starts each vehicle TPMS specification.
The first image shows the type of TPMS sensor on the vehicle.
The following three images show the requirements for servicing the
wheel: process, scan tool and OEM scanner.

The red border, yellow border or grayed appearance of the image
denotes the requirement as required, optional or not required. Red
and white striped border indicates the requirement is possibly
required; refer to the explanation below the images.
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Scroll up or down by dragging the scroll bar, or touching the “up”
and “down” arrows on the right side of the screen. Touch the “Home”
button to return to the main TPMSpecs® Menu.

Touch the “arrows” to navigate backward or forward. Touch the
“print” button to print the current page. Touch “X” to return to the
balancer screen.

Clean Threads

From the main balance screen, touch the “Tools” > “Clean Threads”
buttons. The main Clean Threads Explanation screen is displayed.

Follow the on-screen instructions to clean the spindle threads. After
the spindle threads are cleaned, touch the “Exit” button to return to
the main balance screen.

Balance Bare Rim

From the main balance screen, touch the “Tools” > “Balance Bare Rim” buttons. The balance screen is displayed with a bare
rim. During bare rim balancing, the load roller is disabled.

Balance the rim as normal, taking dimensions, applying weights, etc. Touch the “Balance Rim With Tire” button to return to
standard balancing.
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8. Maintenance

8.1. Calibration Procedures
eCal™ Auto-Calibration

The HD® Elite utilizes eCal™ automatic calibration. Once the balancer is calibrated at installation time, no further operator
input is required.

Calibration Check

A quick calibration check can be performed on the balancer using a calibration weight. From the main balance screen,
touch the “Tools” > “Quick Calibration Check” buttons.

Screw in the calibration weight and clamp a large cone
or collet to the shaft. Lower the hood and press start to
begin the check.

Rotate the shaft to the 12:00 position until the yellow dot
on the screen turns green to complete the check.

8.2. Cleaning the Console
Safety Instructions

• Please keep the display away from any heat sources such as electric radiators or direct sunlight. Place the display in a
stable and well-ventilated place.

• The holes or openings on the display are designed for ventilation. Do not cover or block the ventilation holes or openings
with any objects.

• As the display surface is vulnerable to scratches, avoid touching the surface with nail or pen point.

• Do not attempt to repair this product yourself! Improperly disassembly of the product may expose you to danger! If your
problem cannot be solved according to the “Troubleshooting” guidelines, contact your regional HP authorized service
provider, https://support.hp.com/us-en.

Optical Scan Rim Measurement Maintenance or Service

This Laser Product is designated as a Class 3R Laser during all procedures of operation. Never look directly into the laser.
Doing so may cause serious injury. Do not intentionally use a reflective device to enhance or re-direct the laser. Do not
operate the laser if the cover or seal is damaged.

There is no required maintenance or service to keep the Optical Scan Rim Measurement Laser System in compliance. The
laser is not a field serviceable part or an adjustable part. Any necessary repair or maintenance should be done by the
factory only. The Optical Scan Rim Measurement Laser System has no field serviceable parts. The unit should never be
opened or modified.
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Optional HammerHead® TDC Laser Clip-On Weight Locator Maintenance or Service

CAUTION
Use of controls or adjustments or performance of procedures other than those specified herein may result in
hazardous radiation exposure.

Do not stare into the beam or view directly with optical instruments. Doing so may cause serious injury.

Do not intentionally use a reflective device to enhance or re-direct the laser. Do not operate the laser if the cover or seal is
damaged. There is no required maintenance or service to keep the HammerHead® TDC Laser System in compliance. The
laser is not a field serviceable or an adjustable part.

Any necessary repair or maintenance should be done by the factory only. The HammerHead® TDC Laser System has no
field serviceable parts.

8.3. Cleaning and Lubricating the Adjustable Flange Plate and Pin
Cleaning and Lubricating the Adjustable Flange Plate

CAUTION
DO NOT pry or hammer stuck pins from adjustable flange plate. The tab at end of pin is made of mild steel
that can be deformed by excessive force. Disassemble adjustable flange plate as described below to remove
stuck pins and diagnose problem.

NOTICE
If adjust ability of flange plate becomes difficult, clean and lubricate the plate.

1. Use a standard screwdriver to pry retaining spring, 98-405-2, from the backside of adjustable flange plate.
Remove the thumbscrew through the side of the flange plate as follows:
Open and then remove the split retaining ring from the thumbscrew, 75-651-1. Unscrew the thumbscrew from the
flange plate.

2. Clean grease and grime from hub and guide. Apply light machine oil or light grease to the mating surfaces (including
around the slots on the interior surfaces of both the hub and guide).

3. Secure the guide to hub with retaining spring previously removed. Secure the thumbscrew to the flange plate with the
split retaining ring.

Pin Assembly Maintenance

Replace tab, 218-185-2, as follows:

Remove pin guide, 135-377-2, from end of the pin assembly and remove the old tab. On one side on the tab the edges are
rounded and the other side has sharp edges. Install the new tab with the rounded edges toward the collar, 217-54-2, of the
pin assembly.

Match the flat section on the mating surfaces of tab and collar. If a flat washer was located between the tab and pin guide,
reassembly the pin assembly with this washer in place. Using Loctite 222 on the threads, secure the tab with the pin guide.

Springs, 98-403-2, must be installed with the concave sides facing each other. When correct, only the outer edges of
the springs will contact each other, creating a clam appearance. All the pin assemblies must have the springs installed
consistently in this manner.
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If the installation and removal of pin sleeves becomes difficult, clean inside of pin sleeves and the pin assemblies, and then
apply light machine oil to the mating surfaces. If pin sleeves do not stay on pins, clean excess oil from inside of pin sleeves
and the pin assemblies. If the problem persists, replace the two O rings, 124-149-2, on the ends

8.4. Maintenance Schedule

Table 2. Follow schedule to keep balancer performing at its best

Maintenance Schedule Perform the following Maintenance

Daily • Spindle Maintenance - Keep the spindle shaft assembly and wing nut threads clean
and lubricated. Clean the spindle threads by running the edge of a rag between the
threads while turning the spindle by hand. Lubricate the shaft with a coating of light
lubricant with Teflon® such as Super Lube® by Loctite after cleaning.
Do not lubricate the spindle hub face-mounting surface. This could cause slipping
between the wheel and the hub face. Keep the hub face-mounting surface clean and
dry.

• Collet maintenance - Keep the mounting collets clean and lubricated. Lubricate with
a coating of light lubricant with Teflon® such as Super Lube® by Loctite. Inspect
cones for excess wear, dings, burrs, or other damage that may prohibit proper
centering.
Do not use cones in any way that is not described in the operation manual. This
could cause damage to the mounting cone and not allow for proper mounting of the
wheel.

• Inspect wingnut and clamp cup for excessive wear or damage.

• Cleaning the console - When cleaning the console use the included Armor All Glass
wipes to wipe off the display console and cabinet. Do not spray any type of cleaning
solution directly onto control panel or LCD resistive touch screen. Do not use shop
air to clean the display. Power should be off prior to cleaning the LCD resistive touch
screen
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Maintenance Schedule Perform the following Maintenance

Periodically (when
balancer chases weight
on check spin)

• Perform a QuickCal Check to determine if calibration is necessary. This should be
performed after balancer has been in operation for at least 10 minutes.

Monthly • Inspect inlet air filter/dryer - clean, replace as necessary

Semi-Annually Preventative maintenance visit by Hunter Service Representative which will include all
the above in addition to the following:

• Perform audit check (quality report for vibration control system)

• Perform full system diagnostics (including air system)

• Load roller friction material inspection

• Check printer operation

• Cone inspection with dial indicator

• Check belt tension

• Full system calibration

NOTICE
The end user is responsible for replacement of all consumable items such as printer ink cartridges, cleaning
wipes, and batteries.

CAUTION
Do not use shop air to clean the LCD resistive touch screen. Shop air could be wet, dirty, or too powerful for the
display and can cause problems with the display.
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